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PowerSchool SIS: PowerTeacher Pro Part 2 
PowerSchool's HTML-based gradebook, PowerTeacher Pro, includes advanced features for 

standards-based grading, traditional grading, student performance analysis, and reporting. 

In this course, learn how to use the gradebook to: 

• Work with final grades 

• Assess student and class performance 

• Run PowerTeacher Pro reports 

Working with Final Grades 
Final grades are updated automatically throughout the term as you enter assignment scores 

in the gradebook. When the term comes to a close, however, you may have additional tasks 

to perform before submitting grades for report cards to make sure your final grades are 

accurate. For example, you may have to enter standards grades, modify individual scores, 

enter citizenship scores, or award variable credit. Occasionally, you may also need to modify 

a student’s final grade in a course based on effort, participation, or other performance 

factors. 

Modifying Final Grades 
To work with final grades, click Grading and use the links in the Grades section. Access the 

same links through the Quick Menu—the arrow next to the heading at the top of the grading 

pages. 

 

Click Traditional to view the traditional grades for an entire class, along with a summary of 

how many absences, tardies, missing assignments, late assignments, and incomplete 

assignments each student has. To edit the final grades, click in the first column and edit the 

data in the Score Inspector. The grades correspond to the reporting term you select in the 

term menu in the top-right corner of the page. To see grades for a different term, open the 

term menu and select a reporting term code. 
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Open the Quick Menu and click Standards to view or edit the standards final grades for an 

entire class for the selected term. Use the Standards page when preparing for report cards 

to quickly evaluate or modify your students' standards grades. Hover your cursor over a 

standard identifier to view the standard name and description. To edit a final grade for a 

student, click in the grade cell for a standard and edit the data in the Score Inspector. To 

evaluate the supporting assignment scores for a standards grade, in the Score Inspector, 

click the graph icon to open the view-only standards progress graph for the selected 

standard and student. 

The progress graph shows how the student performed on the standard over a period of 

time. Use the arrows to the left and right of the standard ID in the Score Inspector to view 

graphs showing the selected student’s performance on other standards assessed this term. 

To open the student's Standards Progress page to change the supporting assignment 

scores, click Show More at the top of the graph. (Learn more about the Standards Progress 

page in the Analyzing Performance section of this course.) Click the graph icon in the Score 

Inspector again to close the progress graph. To view additional standards metrics, click the 

gear icon at the top of the Standards page and then select Show Metrics to view the 

mean, median, and mode statistics. 

If you see the Professional Judgment Indicator on the Standards page, note the student’s 

name and the standard label. Then click Students, select the student, and click Standards 

Progress. Locate the standard on the student’s Standards Progress page. Scroll, if 

necessary, to see the term that features the indicator. Click the assignments icon at the 

right to view a graph of all scores on assignments aligned to that standard. You will 

probably see that one of the most recent scores doesn’t seem to fit the pattern the student 

displayed through the rest of the term. If his performance on that assignment does not 

accurately reflect his mastery of that standard, modify the final grade for the standard. 

Return to the Grading options and choose Comment Verification to view or add final 

grades comments. Use this page when you are getting ready to complete grades for report 

cards. To add or edit a comment, click a student’s final grades and click the Comment icon 

in the Score Inspector. Add comments for additional students and click Save. 

Open the Quick Menu and select Category Totals to view a summary of students’ grades 

by assignment category. Use category totals to assess how students performed in one 

assignment category versus another, or to analyze the difficulty of one category type versus 

another. For example, if students received significantly lower scores on assignments in the 

Homework category than in the Test category, you might revisit the homework assignments 

and analyze their difficulty. To view additional metrics, click the gear icon at the top of the 

page and then select Show Metrics to view the mean, median, and mode statistics. 

To view and work with students’ final grades from all reporting terms, open the Quick Menu 

and click All Reporting Terms. Each column represents a reporting term. The column that 

corresponds to the current term is highlighted. Click a student’s final grades for a reporting 

term and use the Score Inspector to modify scores or add comments. 

Click Save after you make any grading changes. When you change a final grade manually, 

the cell that contains the student’s final grade will have a small triangle in the upper-left 

corner, indicating that the grade has been modified manually. The Score Inspector will 

display both the modified grade and the original calculated grade. To revert to the 

calculated grade, click the Undo icon in the Score Inspector. 

To work with the final grades for students in another class, click the name of the currently 

selected class at the top of the gradebook window and choose a different class. 
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Activity 1 – Modify a Final Grade 
You’ve evaluated a student’s performance and found that you need to modify the student’s 

final grade to account for increased effort and demonstration of standards mastery. Edit the 

student’s final traditional and standards grades in the gradebook. 

1. Click Grading 

2. Click Traditional 

3. Click a student’s final grade 

4. In the Score Inspector, edit the student’s grade to be higher than it is currently 

 

For example, change a letter grade of A- to A and a percentage of 91 to 94. 

5. Click Save 

 

Notice that the student’s final grade cell has a small triangle in the upper-left corner, 

which indicates that the grade has been modified manually. 

6. Open the Quick Menu and select Standards 

7. Click a standards grade for the same student 

8. In the Score Inspector, click the graph icon to open the view-only standards progress 

graph for the selected standard and student 

9. Review the progress graph to see how the student performed on the standard over 

time, then click the graph icon in the Score Inspector again to close the progress 

graph 

10. Using the Score Inspector, edit the student's final standards grade 

 

For example, change a score of 3 to 4 or a score of M to E. 

11. Click Save 

Viewing Dropped Students 
When working with final grades, if you need to view, modify the final grades for, or enter 

comments about the students who have dropped your class, do so from the Traditional 

grades page.  

To view a dropped student, select the class the student was in and click Grading. Then click 

Traditional. Click the gear icon and select Show Dropped Students. 

Click the student's final grade to modify the grade or to enter comments using the Score 

Inspector. Then click Save. To return to the list of currently enrolled students, click the gear 

icon and select Show Active Students. 

Entering Citizenship Scores 
If your school doesn't track behavior through standards, then your district leaders may 

enable citizenship score entry and set up a citizenship scale that includes codes, like S for 

Satisfactory or N for Needs Improvement, for you to use in PowerTeacher Pro. If your school 

policy requires you to enter citizenship scores for your students, use the Traditional grades 

page to do so. 
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Activity 2 – Enter Citizenship Scores 
The end of the term is approaching and you've been reviewing students' final grades and 

making adjustments as needed. Now that you're done with the academic grades, it's time to 

focus on your students' behavior scores. Your school does not track students' behavior 

through standards. Instead, your school has its own citizenship grading criteria, and 

teachers enter an overall citizenship score for each student that will appear on the student's 

report card. Enter your students' citizenship scores in PowerTeacher Pro. 

1. Click Grading 

2. Click Traditional 

3. Click in a student's cell in the Citizenship column 

4. In the Score Inspector, select a citizenship score, such as S 

5. Enter citizenship scores for the rest of the students 

 

If the majority of your students received the same citizenship score, enter the scores 

that are different first, then fill the common scores to save time. 

6. Click Save 

Awarding Variable Credit 
If you teach at a school that has an alternative education program or any sections in which 

students can earn variable credit hours for a course, your school administrator can set up 

PowerSchool SIS so that you can enter variable credit for students in PowerTeacher Pro. 

Using variable credit, teachers can specify how much credit each student attempted 

(potential credit) and how much credit each student is awarded (earned credit), regardless 

of the credit hours specified for the course or the grade the student earned for the class in a 

term. 

Once variable credit is enabled for one or more of the sections you teach, use the 

Traditional grades page to enter variable credit. Click Grading and select Traditional. If 

your school's transcripts include both awarded and attempted credit, you'll see two columns 

on the Traditional page for entering the variable credit values. If transcripts include only 

awarded credit, then you'll see only one column for entering the credit values in 

PowerTeacher Pro. Keep in mind that the character limit for a variable credit entry is 7 

characters. 

In some cases, students who earn traditional credit hours and students who earn variable 

credit hours are enrolled in the same sections. For example, students may earn variable 

credit in a course if the course requirements have been partially satisfied due to interrupted 

attendance in the course because of mid-semester enrollment, transfer, or significant 

absences. In these classes, teachers enter the variable credit for only those students for 

whom variable credit is applicable. 

Activity 3 – Award Variable Credit 
It's the middle of the term and one of your students is transferring to a school in another 

district. Your school's policy allows for credit to be awarded for in-progress work when 

students transfer out of the district. The course you teach is worth 1 course credit and is 

identified in the course catalog as a variable credit course. The student completed half of 

the course requirements. Enter the student's awarded and attempted credits in 

PowerTeacher Pro. 
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1. Click Grading 

2. Click Traditional 

3. Click in a student's cell in the Awarded column 

4. Enter .5 as the number of credits the student earned 

5. Click in the same student's cell in the Attempted column 

6. Enter 1 as the number of credits the student attempted 

7. Click Save 

Recalculating Assignment Scores and Final Grades 
Although grades in PowerTeacher Pro are calculated automatically, you can force a 

recalculation, if necessary. Use the recalculate tool after making significant changes in the 

gradebook, such as adding multiple assignment scores for students who transferred from 

another class. Also, recalculate assignment scores, special codes, and final grades when 

your PowerSchool SIS administrator changes a setting that affects the gradebook, such as 

the grade calculation formula or grade scale. 

To use the recalculate tool, click Grading and then select Traditional. Click the gear icon 

and then select Recalculate Final Grades. Select the classes for which you are 

recalculating grades. To recalculate traditional grades, check Traditional Final Grades. To 

recalculate standards scores, check Standards Final Grades. To update existing 

assignment scores and special codes, open the Advanced Options pane and check Refresh 

Assignment Scores. (Recalculate assignment scores only when your PowerSchool SIS 

administrator changes the grade scale after you've entered scores.) Then click Recalculate. 

Don't worry. If you've modified final grades manually, when you recalculate grades, the 

modified grades will not revert back to the system-calculated grades. Remember, if you 

wish to revert to the calculated grade, use the Undo icon in the Score Inspector. 

Note: You can also access the Recalculate Final Grades link under the gear icon by clicking 

Grading and selecting Scoresheet, Standards, Comment Verification, Category Totals, or All 

Reporting Terms. Or, click Students and then select Assignments, Standards Progress, or 

Comment Log. 

Submitting Final Grades 
At the end of the term, notify your school’s PowerSchool SIS administrator that you have 

finished entering the scores for the term and that final grades are ready to be stored. Or, if 

you are not yet done with final grades and the final grade deadline is near, send a status 

comment to your PowerSchool SIS administrator, such as Final grades will be done by 

Friday. Your PowerSchool SIS administrator will see the final grade statuses of your 

classes, along with any status comments you've submitted, by running the Section 

Readiness report in PowerSchool SIS. 

Activity 4 – Submit Final Grades for Semester 2 
It's the end of the Semester 2 term and you've completed final grades for your classes. 

Update the final grade status in PowerTeacher Pro to let your PowerSchool SIS 

administrator know that grades are done and ready to be included on report cards. 

1. Select a class and verify that you are in the S2 term 

2. Click Grading 
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3. Select Traditional 

 

Or select Standards or Comment Verification. 

4. On the bottom of the page, click Final Grade Status 

5. To indicate that you have completed your final grades, check S2 Final Grades are 

Complete 

6. Enter a comment indicating that final grades are complete and click Save 

 

The green check mark next to "Final Grade Status" indicates that final grades are 

complete. 

 

 
 

Remember, if you aren’t finished with final grades yet, leave the check box clear, 

enter a status comment indicating when you will be finished for your PowerSchool 

SIS administrator, and click Save. 

7. Repeat the process for one of your other classes 

Understanding Locked Reporting Terms 
At the end of a reporting term, your PowerSchool SIS administrator may choose to lock the 

reporting term to prevent changes to grades so that the grades in teachers' gradebooks 

remain the same as the grades that have been stored in PowerSchool SIS and included on 

report cards. Your PowerSchool SIS administrator will define the dates on which reporting 

terms will be locked. Once a reporting term is locked, you will not be able to change final 

grades, assignment scores, or assignments that have been scored. Additionally, if you 

recalculate final grades, grades in any locked terms will not be recalculated. 

If your school or district leaders decide to lock reporting terms, you will see warning 

messages at the top of PowerTeacher Pro pages, such as the Assignments and Scoresheet 

pages.  

• Before the reporting term is locked, you will see a warning message indicating when 

the reporting term will be locked  

 

For example, you may see a message that says the reporting term will be locked in 

five days. Be sure to complete final grades before the end of the lock date.  

• Once a reporting term has been locked, you will see a message indicating that the 

term is locked 

If you attempt to score an assignment or a standard aligned to an assignment that has a 

due date in a locked term, you will also see a message in the Score Inspector indicating that 

the score is locked. 

What if you need to correct a final grade after a term is locked? If you need to change 

assignment scores or final grades after a reporting term has been locked, contact your 

PowerSchool SIS administrator. Your administrator can temporarily unlock one or more of 

your classes so that you can make the necessary changes. 
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Analyzing Performance 
Use the gradebook to analyze student performance at any time during the school year. 

Analyze performance throughout the term to ensure that students are mastering the skills 

and standards you are teaching. Review students’ performance as you prepare to complete 

final grades for report cards, and then use the gradebook to prepare for and conduct 

parent-teacher conferences. 

Review how students in an entire class are performing using the Progress pages. The 

individual student pages provide helpful information during parent-teacher conferences to 

explain why a student earned a particular grade. 

Individual Student Performance 
To analyze an individual student’s performance, begin by selecting the class the student is 

in at the top of the gradebook window. Then, click Students and select the student. 

Assignments 
To view a summary of the student’s grades and assignments for the selected reporting 

term, click Assignments. The Assignments student page is similar to the Assignments page 

you view for the entire class, except that it shows only the assignments and scores for the 

selected student. View a summary of the student’s course grades at the top of the page. 

Click the gear icon next to the term menu and choose Show Filter to use the filter to 

search for assignments by assignment name, due date, score, or standards. The 

assignments are listed by the most recent due date by default. To view the details of the 

standards that are aligned to an assignment, click the icon in the Standards column. Click 

OK to close the Assignment Standards Detail window. 

Standards Progress 
To navigate to the student’s other pages, use the Quick Menu. For example, to view the 

student’s standards grades, open the Quick Menu, scroll down below the list of student 

names to the Student View submenu, and select Standards Progress. The Standards 

Progress page shows the student’s standards grades for each standard that was assessed 

by reporting term. The column that corresponds to the selected term is highlighted. 

Compare the grades the student received in each term to assess his or her progress. 

To view the assignments that you used to assess the standard, click the icon in the 

Assignments column. Use the graph at the top of the page to see how the student 

performed over time on the standard. For example, if the standard was assessed on four 

assignments, you can see the four standards scores the student received. If the calculation 

method is set to the three most recent scores, you can see those scores next to green 

circles on the graph and a dotted line that represents the calculated score. 

In this example, you can see that the student’s calculated standards score is 2+, based on 

the three most recent scores. You can also see that the student’s demonstration of standard 

mastery decreased over the three most recent scores, so use your professional judgment to 

determine whether or not the student truly mastered the standard. 
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As outlined in the "Working with Final Grades" section of this course, you can also view a 

student's Standards Progress graphs directly from the Standards page by clicking the 

student's standards grade, and then clicking the graph icon in the Score Inspector. 

To see a summary of the standards scores statistics, click Show Metrics below the graph. 

• Most Recent – The average of the most recent score(s) 

• Mean – The mathematical average of the scores 

• Median – The middle of the scores (half of the scores are above this number and half 

are below) 

• Mode – The most common score achieved 

• Weighted Mean – The average of the scores based on the average of total weighted 

points 

• Highest – The highest score 

These statistical values are indicators of how well the student did on a specific standard. If 

any of the values are low, it may mean that the student needs additional practice on the 

skill or concept you’re assessing, or you may need to revise the assignment. To view the 

student’s performance on additional standards, open the Quick Menu and select a standard. 

The orange Professional Judgment Indicator may appear next to a student’s standard score 

on the Standards Progress page when evidence exists for mastery that may differ from the 

student’s calculated standard score. To evaluate the student’s level of mastery, click the 

Assignments icon next to the standard score. 
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In the example below, the student earned a standard score of 2 on most of the 

assignments, except for the last one. The student’s calculated score is based on the three 

most recent scores, so the last score is included in the calculation, bringing his overall score 

down to a 2-. Use your professional judgment to evaluate whether or not the calculated 

score is a true indication of the student’s level of mastery. For example, if the student was 

ill or had a bad test day, the last score may not be a true indicator of his skill level, so you 

could choose to ignore that score and change the calculated score from a 2- to a 2. 

 

Graphing Additional Standards or Metrics 
To compare a student’s progress on up to four standards, click the gear icon next to the 

term menu on the Standards Progress page. Then click Progress Options. In the Progress 

Options window, select the standards you want to include in the comparison and click OK. 

Then, click the Show/Hide Graphs icon next to the gear icon to view the student’s progress 

on all of the selected standards. Click one of the symbols, such as a triangle, on one of the 

line graphs for a different standard to highlight it and view the scores. Below the graph, 

view the calculated standard grades, the metrics, the aligned assignments, and the scores 

for the standards included in the comparison. 
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By default, the Standards Progress graph displays a green dotted line that corresponds to 

calculated standard score for the term, determined by the chosen metric, such as Most 

Recent. 

To add additional metrics to the graph, click the gear icon next to the term menu on the 

Standards Progress page and select Progress Options. In the Progress Options window, 

open the "Additional Metric To Graph" menu and select a metric, such as Highest. Then 

click OK. A gray dotted line appears on the graph, indicating the score that corresponds to 

the selected metric. 

 

Standards Scoresheet 
To view a summary of the student’s standards scores on all of the standards aligned to 

assignments for a reporting term on a single page, click Standards Scoresheet.  
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Click any assignment score to open the Score Inspector and edit the score. Click any 

standard grade to access the Standards Progress graph. Click the gear icon next to the term 

menu on the Standards Scoresheet page to hide the summary, show metrics, filter 

standards, or recalculate final grades. 

When filtering standards, only the assignments associated with those standards are included 

in the Standards Scoresheet. To filter standards, click Filter Standards. All standards are 

selected by default, so clear the first check box below the Filter area to clear all selected 

standards, then type part of a standard number or description in the Filter area and click 

Apply. Select the check box next to each standard you wish to see and then click OK.  

If you used PowerTeacher Gradebook previously, you'll find that the Standards Scoresheet 

in PowerTeacher Pro is similar to the Student View in PowerTeacher Gradebook. 

Transfer Scores 
Use the Transfer Scores page to copy the assignment scores from a student's dropped class 

into a new class when that student transfers into your class or moves between two sections 

of a class you teach after the term has started. Scores from any term can be copied, even if 

the previous term is locked. Scores can be copied to any term, except to a locked term. 

Comment Log 
To view all of the comments you’ve recorded for the student, click Students and select 

Comment Log. Depending on the types of comments you’ve entered for the student, the 

comment log may show class grade comments, standards grade comments, and assignment 

comments. 

Demographics 
To view the student’s demographics information, such as his date of birth or mother’s phone 

number, open the Quick Menu and select Demographics.  

Teachers can have access to the most up-to-date information about contacts relating to 

their students when viewing the Demographics page. Administrators may choose to set up 

PowerSchool SIS so that you can see the contact information from any student contacts. 

Regardless of the district setting, some student contact data will be available in 

PowerTeacher Pro if the district has enabled the student contacts feature. This includes 

email addresses, phone numbers, employer, and original contact type, if set. Other contact 

information can be enabled by your administration. 

Quick Lookup 
To view the student’s traditional Quick Lookup page, open the Quick Menu and select Quick 

Lookup - Traditional. The traditional Quick Lookup page is the same page that 

administrators see in PowerSchool SIS and shows the student’s attendance for the last two 

weeks, his current schedule, his current grades, a summary of his total absences and 

tardies, and his current GPA. 

Click a final grade to see the scores and flags for the student’s assignments, and to see the 

standards score information. Click the Standards icon to view the standards aligned to an 

assignment. Parents, students, and administrators will also see this information for all 

PowerTeacher Pro sections. 
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To view the student’s standards Quick Lookup page, open the Quick Menu and select Quick 

Lookup - Standards. Then click the arrow next to one of the student’s classes to view the 

standards aligned to the course and the student’s standards final grades. Click a standard 

final grade to view details about it. When a student is graded on the same standard in 

multiple classes, the student's final grades on that standard can be averaged into one final 

grade—view the standard grade rollup information on this page. 

PowerTeacher Portal 
To view the selected student’s screens in PowerTeacher, open the Quick Menu and select 

PowerTeacher Portal. PowerTeacher opens in a new window so that you don’t lose your 

place in PowerTeacher Pro and one of the student’s screens is visible. The screen that 

appears depends on which screen you set up to be the default student screen in 

PowerTeacher. For example, you may see the student’s Schedule screen. 

Activity 5 – Review an Individual Student’s Progress 
In preparation for an upcoming parent-teacher conference, review a student’s performance 

using the Assignments and Standards Progress student pages. 

1. At the top of the gradebook window, select a class 

2. Click Students 

3. To view the selected student’s performance, click Assignments 

4. Review the student’s course grades and individual assignment scores, then open the 

Quick Menu and select Standards Progress 

5. Review the student’s standards scores for each reporting term, then click the number 

in the Assignments column for one of the standards 

6. Review the graph of standards scores, then click Show Metrics to review the 

student’s statistical values for scores on assignments aligned to this standard 
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7. Click Students and select a different student to view his or her Standards Progress 

page 

Activity 6 – Find Attendance Information on the Quick Lookup Page 
Find a student who has a missing assignment from the previous week, then check the 

student’s attendance information to see if an absence accounts for the missing work. 

1. Click Grading 

1. Select Scoresheet 

2. Click the gear icon 

3. Select Show Assignments from Most Recent 

4. Scroll through the table to find a student who either has no score or a Late, Missing, 

or Exempt flag for an assignment from last week 

5. Click the student’s name 

6. Click the arrow next to the page name at the top of the page to open the Quick Menu 

7. Select Quick Lookup – Traditional 

 

In the Attendance By Class section of the table, view the student’s attendance for 

this week and last week. See the total absences and tardies for the current term on 

the right side of the table. 

Now that you've learned how to work with the Student View pages and analyze an individual 

student's performance in PowerTeacher Pro, try this challenge activity on your own. Find the 

answer key with step-by-step instructions attached to this course as a supplement. 

Challenge Activity 1 – Working with an Individual Student 
Locate one student in a class that has assignments and grades. Take note of the student's 

name. Then find the answers to the following questions. 

1. How old is the student? 

2. How many times was the student tardy in all of his or her classes during the 

Semester 2 term? 

3. What is the student's Semester 2 final grade for the first course standard in his or 

her fourth-period class, or fourth subject? 

4. How many standards are aligned to the most recent assignment that the student 

completed in Semester 2? 

5. How many times has the student accessed the student portal in PowerSchool SIS? 

Class Progress 
To analyze the performance of an entire class, begin by selecting the class at the top of the 

gradebook window. Then, click Progress. Depending on how the gradebook is set up, you 

can view class progress on traditional grades and standards grades. 

Traditional 
To view traditional grades progress, select Traditional from the Progress menu. The graph 

on the Traditional Grades Progress page shows the distribution of grades for the class for 

the selected reporting term. 
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The column on the left lists the number of students who have earned each traditional grade 

in the grade scale. The colors in the graph correspond to the grade scale color levels. For 

example, if the grade scale defines the grades A and A- as dark green, the graph displays a 

dark green bar that corresponds to the number of students who have an A or A-. To view 

the traditional grades included in each color level, click the information (i) icon. 

The black demarcation line shows where the cutoff is between passing and failing grades. 

The numbers in the column on the right show the total number of students who have 

passing grades versus the total number of students who have failing grades. 

To the right of the graph, view a summary of the total number of students who have 

missing, late, or incomplete assignments. 

Click View All to open the Traditional Grades Distribution window. On the left side of the 

Traditional Grades Distribution window, view the grade distribution for each reporting term 

in the school year. Click the information (i) icon to view the grades included in each color 

level. On the right, view the grade trends of the students in the class for the selected term, 

compared to the previous term. A red arrow in the Grade column indicates that the 

student’s grade is trending down between the selected terms. A green arrow indicates an 

upward trend, while no arrow indicates no change. You can see which students are 

performing better or worse between terms. To compare trends between a different selection 

of subsequent terms, click a term in the Grade Distribution column. Click the gear icon in 

the upper-right corner to select additional trend comparison options. To close the window, 

click X in the upper-right corner. 

Standards 
To view standards grades progress, select Standards from the Progress menu. The graph 

on the Standards Progress page shows the distribution of grades for each standard aligned 

to the course, for the selected class and reporting term. 

All of the standards aligned to the course are listed in the Standards column. To the right of 

each standard, view a graph that displays the distribution of grades for the class. The colors 

in the graph correspond to the grade scale color levels. For example, if the grade scale 

defines the standard grade 4 as dark green, the graph displays a dark green bar that 

corresponds to the number of students who have a 4. The black demarcation line shows 

where the cutoff is between passing and failing grades. The numbers above the colored bars 

show the total number of students who have passing grades versus the total number of 

students who have failing grades. The graphical display makes it easy to see whether or not 

students in the class are demonstrating mastery of the standard, and helps you consider 

your instructional response. If, for example, you find that most of the students have failing 

grades, you may decide to reteach the concept or provide more opportunities for practice. 

Click the graph to open the Standard Grades Distribution window. On the left side of the 

Standard Grades Distribution window, view the grade distribution for the selected standard 

for each reporting term in the school year. On the right, view the grade trends of the 

students in the class for the selected term, compared to the previous term to see which 

students have mastered the standard and which ones need more practice. A red arrow in 

the Grade column indicates that the student’s level of mastery is trending down between 

the selected terms. A green arrow indicates an upward trend, while no arrow indicates no 

change. To compare trends between a different selection of subsequent terms, click a term 

in the Grade Distribution column. 
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To change the display, click the gear icon at the top of the Standard Grades Distribution 

window. If a course group is currently selected instead of a single course, you might want to 

display student names by class. Elect whether to show empty grades, to display the trend 

icons, and what term to compare the currently selected term against. To close the window, 

click X in the upper-right corner. 

On the right side of the Standards Progress page, the number in the Assignments column 

indicates the number of assignments that you’ve used to give students opportunities to 

practice the standard or to assess their levels of mastery. To view the assignments aligned 

to a standard, click the Assignments icon. The Standards Assignment Trend window lists the 

aligned assignments by category, name, due date, and score type. Use this window to 

analyze the types of assignments that you’ve used to assess the standard, or click the name 

of an assignment to view or edit the students’ individual scores. To close the window, click X 

in the upper-right corner. 

Activity 7 – Review Class Progress 
Periodically throughout the term, you like to review the progress of your classes to analyze 

trends and to keep an eye on how students are progressing towards standards mastery. In 

some cases, you adjust standards scores based on your professional judgment of how 

students are demonstrating mastery. Review the distribution of traditional and standards 

grades for a class. Then make changes to students’ standards scores on an assignment and 

return to the Standards Progress page to review the changes. 

1. At the top of the gradebook window, select a class 

2. Click Progress 

3. Click Traditional 

4. View the distribution of traditional grades and answer these questions: 

 

How many students have failing grades? How many missing assignments are there in 

the class? 

5. Click View All 

6. Compare the students’ grades trends in the current term to the previous term and 

answer these questions: 

 

How many students' grades are worse in the current term? How many students' 

grades are better in the current term? 

7. Select a different term in the Grade Distribution column and view the students' 

grades trends 

8. Close the Traditional Grades Distribution window 

9. Click Progress 

10. Click Standards 

11. View the Grade Distribution chart for the first standard listed and answer these 

questions: 

 

How many students are demonstrating mastery? How many students are not? 

12. Click the Assignments icon next to the first standard 

13. Click the name of the first assignment 
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14. In the first standard column, change several students’ passing scores to failing 

scores and then save the scores 

15. Navigate back to the Standards Progress page and review how the distribution of 

grades for the first standard has changed 

Running PowerTeacher Pro Reports 
The gradebook contains several reports that you can view onscreen or print. Personalize 

each report by entering a custom title, top and bottom notes, signature line, and by 

specifying fields to use or criteria to use. The following table provides brief descriptions of 

the reports: 

Report Name Description 

Individual Student Report • Use this report to view or print a summary of the class 

activity per student 

• Include only one class or create a "multi-section" report 

by including the student's full schedule 

• Generate a report similar to the Multi-Section Report in 

PowerTeacher Gradebook that includes scores for any 

course a student or a whole class is taking 

• Include student numbers next to student names for 

identification purposes 

• Present a summary of student work to parents at 

conferences or to a principal during a review, or use the 

report as a midterm update for students and parents 

• Choose whether or not to include course grades and 

attendance, assignments, category totals, standards 

scores, citizenship scores, and comments 

• Print the report for a few students or a group 

Multi-Function Assignment 

Report 

• Use this report to view or print a list of students and 

scores per assignment 

• Use it to find missing, late, or incomplete assignments, 

to help students and parents keep up with class work, to 

target students who need extra help, or to gauge which 

assignments present the most challenges to students 

Scoresheet Report • Use this report to print a copy of the Scoresheet page 

• Include final grades and assignment scores 

• Use student numbers or names 

• Sort students by name, student number, or randomly 

• Use it to post a printout of students' grades 

• Run the report as a PDF or an Excel spreadsheet 
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Report Name Description 

Student Roster • Use this report to view or print demographic information 

by class 

• Use the report to keep track of money collected for 

classroom field trips, or as an emergency contact list, 

for example 

• Customize the report by adding blank columns (the 

report retains the information you entered last) 

• Use the Order arrows to arrange the columns in any 

order 

• Run the report as a PDF or an Excel spreadsheet 

Using the Report Queue 
Use the Report Queue to view and manage reports you've generated. Access the Report 

Queue by either clicking Reports in the navigation menu and selecting Report Queue or 

clicking the Notification icon and selecting Report Queue.  

Reports in the queue are listed by name and date. View the icons in the Status column to 

see if a report is running, pending, completed, cancelled, or if there was an error. Refer to 

the legend for icon definitions. 

To download and view a report, click the report name. To delete a report, click the Delete 

icon in the Actions column. To rerun a report using the same settings you used to run the 

original version, click the Information (i) icon in the Actions column, then click Resubmit. 

To update the status of a running or pending report, click Refresh. 

Activity 8 – Create Progress Reports 
Next week, you have parent-teacher conferences for your struggling students. You've 

already analyzed grades and identified the students who need parent-teacher conferences. 

Now, prepare for the meeting by creating progress reports that you can give to parents for 

their records. 

1. Click Reports 

2. Select Individual Student Report 

3. Enter a report title, such as Progress Report 

4. Open the Classes menu and choose the classes to include on the report 

 

Click outside of the menu to close it. 

5. You don't want to print custom class names on the progress reports for parents, so 

verify that the Use Custom Class Name check box is not selected 

6. Since the progress reports are for your classes only, rather than for all of the 

students' classes, verify that the Use Student's Full Schedule check box is not 

selected 

7. To generate each student's report as a separate file, check Separate Report By 

Student 
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8. In the Sort Options section, open the Layout menu and choose By Section, By 

Student 

9. To sort the report by students’ last names, open the Students menu and choose Last 

Name 

 

To use the preference for how student names are sorted by default in your 

gradebook that you defined under Settings > Display Settings, choose Gradebook 

Preference. 

10. Use the Assignments menu to sort the assignments by due date or by category and 

due date; for example, choose Due Date (Newest First) to list the assignments by 

the most recent due dates 

11. Open the Areas To Include menu and check Course Grade Comments and 

Assignment Comments to include any comments you’ve entered about the 

students in the report 

 

"Course Grades and Attendance," Standards Final Grades, Assignments, and 

Category Totals are checked by default. If citizenship score entry is enabled, select 

Citizenship to include citizenship scores. 

12. Click the Areas To Include menu again to close it 

13. Verify that Show Percentages is selected to include students’ grade percentages in 

the report 

14. To include any assignments that have no grade data, such as those that haven't 

been scored yet, check Show Assignments with no Data 

15. To include the standards identifiers for standards final grades, check Include 

Standards Identifier 

16. To help with identifying students with the same name, add student numbers next to 

student names in the report header by selecting Include Student Number with 

Student Name 

17. To include students’ grades, assignments, and category totals from the current term, 

use the default settings under Date Range 

18. Use the default settings under Data Filters to include any assignments, any scores, 

any category, and any course grades 

19. Scroll to the top of the page and click the Students tab 

20. To run the report for a selection of students rather than for all of the students in the 

classes, click Add/Remove Students 

21. All of the students are selected by default, so clear the check box to the right of the 

Filter area, then in the list of students, check the boxes next to the struggling 

students’ names 

 

For the purposes of this activity, pick a few students at random. 

22. Scroll to the top of the page and click the Format tab 

23. Since you are including all of the available data in the report, leave the page 

orientation set to Landscape to make the text easier to read 

24. Use the default option PDF for the report output 
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25. To create a page break between students, check Page Break 

26. Choose to exclude row shading to save ink during printing 

27. Leave the “Include” check box clear for the Top Note option, since you don’t plan to 

include a note at the top of the report 

28. Since you are meeting the student’s parents in person, you don't need a signature 

line, so also leave the “Include” check box clear for the Bottom Note option 

29. To generate the report, click Run Report 

 

An alert at the top of the window indicates that the report is being processed. 

30. To open the Report Queue, click View Reports 

 

Also navigate to the Report Queue by clicking the Notification icon—which has a red 

number indicating the number of reports that are ready—and then selecting Report 

Queue. 

31. If the report is still running, click Refresh to update the status 

32. To download the completed report, click the report name 

 

Depending on how your computer is configured, the report will be saved as a 

download or it will open in your browser. The report may also be downloaded as a 

zipped file. Now you can print the reports to share them with parents. 

Activity 9 – Run a Student Roster Report 
In the middle of the term, you take your students on an annual field trip to the local art 

museum. Use the Student Roster report to take attendance and to keep track of student 

participation during the field trip. Choose and filter which student contacts to include on 

your roster.  

1. Open the menu at the top of the gradebook window and select the class 

2. Click Reports 

3. Select Student Roster 

4. Enter a report title, such as Field Trip Roster 

5. Since you selected a class before you navigated to the Reports menu, it is already 

selected for the Classes option 

6. If you've customized the names of your classes and want to use the custom names 

in the report, check Use Custom Class Name 

7. To sort the roster of students by last name, open the Students menu and choose 

Last Name 

8. Add columns of student information by opening the Add Columns menu next to 

Student Columns and clicking Add next to Gender and Grade Level 

9. Click Add next to Blank twice to include a column for taking attendance and one for 

tracking participation 

 

A column titled “Name” is included by default to list the students’ names. 

10. Click the Add Columns menu again to close it 
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11. Enter Attendance as the title of the first blank column 

12. Enter Participation as the title of the second blank column 

13. Add columns of contact information by opening the Add Columns menu next to 

Contact Columns and clicking Add next to Contact Name and Contact Phone 

 

Note that the contact options are determined by the district-level settings. 

14. Click the Add Columns menu again to close it 

15. Open the Filter Contacts menu and select the contact type, if desired 

16. Scroll to the top of the page and click the Students tab 

17. Verify that the report applies to all of the students in the selected class 

18. Scroll to the top of the page and click the Format tab 

19. Open the Orientation menu and choose Portrait  

20. Use the default option PDF for the report output 

 

To work with the data in a spreadsheet, choose Excel. 

21. Use the default settings for the rest of the format options 

22. To generate the report, click Run Report 

23. To open the Report Queue, click View Reports 

 

Or, click the Notification icon—which has a red number indicating the number of 

reports that are ready—and then select Report Queue. 

24. If the report is still running, click Refresh to update the status 

25. To download the completed report, click the report name 

 

Depending on how your computer is configured, the report will be saved as a 

download or it will open in your browser. Now you can print the report and take it 

with you on the field trip. 

Activity 10 – Run the Scoresheet Report 
As part of the process you go through to analyze your students' grades, you like to export 

their assignment scores and final grades so that you can work with the data in a 

spreadsheet. Use the Scoresheet report to generate a summary of your students' Semester 

2 grade data in Excel. 

1. Verify that you are working in the S2 term 

2. Click Reports 

3. Select Scoresheet Report 

4. Enter a report title, such as S2 Scoresheet 

5. Open the Classes menu and choose the classes to include on the report 

 

Click outside of the menu to close it. 

6. If you've customized the names of your classes and want to use the custom names 

in the report, check Use Custom Class Name 
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7. To see your students' names in the report, instead of their student numbers, open 

the Student Field menu and select Student Name 

8. You typically view your class rosters in the gradebook by students' last names, so 

sort them the same way in the report by opening the Students menu and selecting 

Last Name 

9. You want to see your students' grades in all assignment categories, so use the 

default setting of Any Category for the Categories menu 

10. Verify that the Final Grades and Date Range menus are set to S2 since you want to 

include students' grades from the entire Semester 2 reporting term 

11. All of the students in the selected classes are included by default, so skip the 

Students tab and click the Format tab instead 

12. Open the Orientation menu and choose Landscape 

13. To generate the report as a spreadsheet, open the Output menu and select Excel 

14. Use the default values for the rest of the settings and click Run Report 

15. To open the Report Queue, click View Reports 

16. If the report is still running, click Refresh to update the status 

17. To download the completed report, click the report name 

 

Depending on how your computer is configured, the report will be saved as a 

download or it will open in your browser. Now you can work with your students' 

grade data in a spreadsheet. 

Activity 11 – Run the Multi-Function Assignment Report 
Before the end of the Semester 2 term, you want to give your students a chance to turn in 

any missing or incomplete assignments. Use the Multi-Function Assignment Report to create 

a printout that you can post for students so that they can take advantage of the opportunity 

to complete the assignments. List students by their student numbers to maintain privacy. 

1. Click Reports 

2. Select Multi-Function Assignment Report 

3. Enter a report title, such as Missing and Incomplete Assignments 

4. Open the Classes menu and choose the classes to include on the report 

 

Click outside of the menu to close it. 

5. To list students by their student numbers instead of their names in the report, open 

the Students menu and select Student Number 

6. To sort the assignments by the most recent due dates first, open the Assignments 

menu and select Due Date (Newest First) 

7. Under Data, clear the Show Percentages and Show Assignment Comments 

check boxes 

 

Check "Show Assignments with no Data" to include students who have no score 

entered for an assignment. 

8. Verify that S2 is selected in the Assignment Date Range menu 
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9. To limit the report to include only missing and incomplete assignments, open the 

Assignment Attributes menu and check Missing and Incomplete 

 

Click outside of the menu to close it. 

10. You don't want to limit the assignments included in the report by a grade range or by 

specific grades, so use the default setting of Any Score for the Assignment Scores 

menu 

 

If an assignment score filter is already set, open the Assignment Scores menu and 

select No Filter. 

11. Similarly, you don't want to limit the assignments included in the report by a specific 

category, so use the default setting of Any Category for the Assignment Categories 

menu 

12. All of the students in the selected classes are included by default, so skip the 

Students tab and click the Format tab instead 

13. Open the Orientation menu and choose Landscape 

14. To generate the report as a printout, open the Output menu and select PDF 

15. To create a page break between classes, check Page Break 

16. To include a message at the top of the report for your students, check Include next 

to Top Note and enter a message, such as All missing and incomplete 
assignments are due for partial credit by Friday 

17. Use the default values for the rest of the settings and click Run Report 

18. To open the Report Queue, click View Reports 

19. If the report is still running, click Refresh to update the status 

20. To download the completed report, click the report name 

 

Depending on how your computer is configured, the report will be saved as a 

download or it will open in your browser. Print the report and post it for your 

students in the classroom. 

Now that you've learned how to work with PowerTeacher Pro reports, try these challenge 

activities on your own. Find the answer key with step-by-step instructions attached to this 

course as a supplement. 

Challenge Activity 2 – Create an Anonymous Printout of Students' 
Grades on Test Assignments 
Your students just took a challenging test and they are anxious to see their grades. You've 

entered the scores on the Scoresheet, and they're published online in the student and 

parent portals in PowerSchool SIS, but you'd like to post the results in the classroom for 

your students to review because some of your students don't have access to the online 

portals. You also want to include the grades students received on other tests so that they 

can compare their performance on the various tests. However, you don't want to include 

students' names on the report to keep their grades private. Create the report. 

Note: If your assigned teacher has no test assignments, choose a different category, such 

as Quiz or Classwork. 
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Challenge Activity 3 – Create a Standards Progress Report for a 
Student 
You're meeting with one of your student's parents to review his Semester 2 standards final 

grades. You'd like to print out a report for his parents that includes his standards final 

grades in all of his classes so that they have the overall picture of how he is progressing 

towards mastery of the standards. Create the report. 

Managing the Change to PowerTeacher Pro 
Successful implementation of a new software application, like PowerTeacher Pro, requires 

careful planning and the use of effective change management strategies. 

Bonus Discussion Activity – Managing the Change to PowerTeacher 
Pro 
Review the PowerSchool SIS PowerTeacher Pro Change Management supplement attached 

to this course, then discuss the following questions with the class or in small groups. 

1. What goals do you hope to achieve by switching to PowerTeacher Pro? 

2. How will the change affect the students, parents, and staff members in your district? 

 

How can you empower staff members, in particular? How can you get them to see 

the benefits of the change in terms of their daily lives? How can you convey a 

positive vision of the post-change future? 

3. How you can make the transition as successful as possible? 

Working with PowerTeacher Pro – Bonus Activities 
PowerTeacher Pro is a versatile gradebook that will support both traditional grading and 

standards-based grading practices. Work through these activities to gain in-depth familiarity 

with the gradebook. 

Bonus Activity 1 – View a Student’s Standards Scores for a Single 
Assignment 
A student comes to you after class to discuss a grade that she received on a recent test. 

Provide her with her scores and the full descriptions of the standards that were assessed on 

the test so that she’ll know what topics to focus on next time. 

1. Click Students 

2. Click the name of the student 

3. Open the Quick Menu by clicking the arrow at the end of the page name 

4. Click Assignments 

5. Locate the assignment in the list and click the graph icon in the Standards column for 

that assignment 

 

The Assignment Standards Detail window displays the full descriptions of the 

standards that were assessed on the test, the student’s score for each standard, and 

any score indicator flags. 
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Bonus Activity 2 – View a Student’s Standards Progress for a Single 
Standard 
Select a student, find her term grades for a standard, and view the student’s scores and 

calculated metrics for the standard. 

1. From the class menu at the top of the page, select the class that the student is 

enrolled in 

2. Click Students 

3. Click the student’s name from the list 

4. Open the Quick Menu and select Standards Progress 

5. In the table, locate a standard 

6. Scroll to the right side of the table and click the number in the Assignments column 

7. In the Standard Grade row below the graph, click Show Metrics to see the average 

of the three most recent scores, the mean, median, mode, weighted mean, and 

highest score 

Finding Additional Help 
Use Help resources to view a list of new features, learn tips and tricks, and access topic 

information. Click the Help icon (which looks like a question mark) in the upper right of the 

screen to find in-app support specific to PowerTeacher Pro.  

Note that the Help system will open in a new browser window. In the top-left corner of the 

Help window, click the navigation bar (which looks like three horizontal lines) to open a 

menu of help topics for PowerTeacher Pro.  

Click the Help icon, select Help, and then click Visit our Community to access the 

PowerSchool Community site. The Community is a place for educators, parents, and 

students to find answers in community forums for their PowerSchool products. 

Key Points 
• Working with Final Grades – View, modify, recalculate, and submit traditional or 

standards final grades 

• Analyzing Performance – Analyze a single student’s progress or the progress of a 

whole class 

• Running PowerTeacher Pro Reports – Use customizable report templates and the 

Report Queue 


